[bookmark: _Hlk201328536]Event Creation Guide for Product Marketing Managers (AEM + Marketo)

📌 What Are You Trying to Do?
Click a link below to jump to that section:
· ✅ Core Event Page Creation (Choose One)
· Create Zoom Webinar
· Create a Live Event Page with a Marketo Form
· Create a Live Event Page with a Hyperlink to an External Site (No Marketo Form)
· Create an On-Demand Page with a Recording of a Previous Webinar
· Share a Live Event or on Demand Filtered View  
· Templates
· Template: Live Event Page with a Marketo Form
· Template: On Demand Video Page
· 🧩 Required Steps or Page Components
· Adding Tags (Required for All Event Types)
· Create a New Speaker Bio if the Person is Not Currently in AEM
· 📚 Reference Materials & Supporting Guidance
· Required Field Reference Table
· Social Share Image Guidelines
· Download the Event Template
· 🔍 Reviewing & Sharing
· Previewing and Reviewing Submitted Pages
· Share a Live Event Filtered View
· 🧪 Approval Process
· Creative Review Instructions
· Marketo Technical Check Instructions
· 🛠️ Setup & Help
· How to Request Access to AEM
· Contact & Help


[bookmark: CreateaLiveEventPagewithaMarketo]Create a Live Event Page with a Marketo Form
Use this for webinars where Marketo will be used for registrations.
Step 1:
Create Your Event and Create an Asana Ticket
 Gather the following information:
· Event Name
· Date and Time
· Zoom Meeting Password (if applicable)
· Event ID(s): One unique ID per time slot
Step 2: (Optional): Use the Template to Prepare AEM Content
If you’d like to prepare your content in advance, you can use the optional TemplateLiveEventPagewithMarketo included in this document.
1. Copy the template into a new Word document (don’t edit the original)
2. Fill out all required fields using your finalized event details
3. Save your completed version — you’ll reuse this when creating the on-demand version of the page
Use your completed template to:
· Build your AEM page
· Share finalized info with Creative and Dave (Marketo) in your Asana task
· Keep everything aligned for registration and promotional needs

Step 3: Sign into Adobe Experience Manager
1. Sign into OKTA to access Adobe Experience Manager.
2. Search your OKTA apps for Adobe Experience Manager and click to log in.
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Step 4: Start a New Content Fragment (Page)
1. Click on HigherEd Events Content Fragments.
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2. Select LIVE Events and then the folder for the year the event takes place (e.g., 2025).
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3. In the top-right corner, click Create → Content Fragment.
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4. From the menu, choose Blog Live Webinar with Marketo Form.
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5. Click Next.

Step 5: Create a Title
1. Type your event title into the Title field.
· This will be used to generate the page URL.
· Do not fill in the Description or Tags fields yet.
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AI-generated content may be incorrect.]Only fill in the title and keep the description and tags blank

2. Click the “Advanced” button.
· AEM will automatically add hyphens between words and convert the title to lowercase.
· However, you still need to manually remove any special characters like :, ?, &, /, (), etc. from the URL field.
[image: ]

3. Click the blue “Create” button in the top right corner.
4. On the next screen, click “Open” (not “Done”) to begin editing your event page.

Step 6: Fill Out the Content Fragment (Page)
Fill in each field using the guidance below.
Use the content you gathered in the Event Template to fill this out accurately. 
 After you finish, click Save, then use the dropdown to select Save and Close.
For extra help, see the Field Reference Table later in the document.
Required Fields are marked with *
· *Event Title: Enter the title of your event
· *Subtitle: Supporting one-liner (max 170 characters).
· *SEO Meta Description: Use your subtitle description, this is what will show up in Google (max 160 characters).
· Private checkbox (optional): Only check this if your event should be hidden from the public listing.
· Social Share Image: Optional — see these instructions on how to upload a social share image Social Share Image Guidelines
· *Tags: Add required tags one folder at a time — see Creating Tags (Required for All Event Types)
· *Time Slots:
· Enter date/time in 24-hour format. (For example, 2:00PM would be 14:00)
· Add your Event ID.
· Select the correct Time Zone.
· Only click Add if offering multiple time slots.
· *Event Duration: Duration in minutes (30, 60, etc.)
· *Event Description: Create a short description of your event. (who, what, why)
· *Marketo Form ID: Always use 21552
· Speaker Bio (optional): Choose from existing bios loaded in AEM or create a new one
SAVE YOUR WORK: Once you are done, click save (down arrow), select Save and Close in the top right corner 
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Step 7: Creating Your Page
1. Click the alert bell icon in the top-right and select View All.
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2. Find your new content fragment (page) and check the box on the image. (You should be able to identify it by it being the most recent one you published)
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3. Click Complete at the top of the page.






4. Click on the checkbox next to page path
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5. Select the folder for live events and then the folder for year (e.g., 2025) and confirm with a checkbox. 

6. Click Select, then OK.




Step 8: Submit the page to be reviewed
1. Go back to the main navigation page  (click on the adobe experience manager logo in the top left corner)
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2. Select HigherEd Events Pages
3. Select the folder you placed your page for example Higher Ed Events | McGraw Hill > Live events > 2025, then find your event.
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4. Select your page by clicking the page to create a blue checkmark and select edit at the top of the page.
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5. Then click on the “page information” icon in the top left hand corner of the screen (shown in red box below) 
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6. Select Start Workflow
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7. Scroll down until you see “HigherEd Live Event Publication Request” and click “Start Workflow
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8. You have submitted your event page and are complete. The review process will now take 2 business days until it goes live.

Reviews typically take up to 2 business days, though more time may be needed if revisions are required.
Step 9: Create Required Asana Tasks
Create the following immediately after Step 8:
· [MKTO: webinar Reg] Task (Required)
· Use the Asana template: [MKTO: webinar Reg]
· Task title format: [MKTO: webinar Reg] Event Name/Date
Include the following in the task: (directions will be provided within the task as well)
· Event Name (as it appears in AEM)
· Event Date and Time
· Sender Info (From Name, From Email, Reply-to)
· Zoom Account Number
· Meeting or Webinar?
· Event Password (if applicable)
· Webinar/Meeting ID
· Zoom Join Link (for Meetings only)
Once submitted, the Marketo team will:
· Create the registration program in Marketo
· Test the form to ensure registration is being captured
· Kick off copy editing workflow
🔹
b. Invite Task (Optional)
If you plan to send an email invite, create a separate Asana task(s) using the “Event Invite” template. Note – the marketo team will require 1 task per email sent.  This includes all invites and any post event follow-ups.  
Include:
· Final event page URL (once published)
· Email content, audience, and timing notes


[bookmark: CreateaLiveEventPagewithaHyperlin]Create a Live Event Page with a Hyperlink to an External Site (No Marketo Form)
Use only if the event is hosted elsewhere (e.g., a partner conference).
Follow the same steps as above, but choose:
· Blog Live Webinar with Link Sign Up (instead of Marketo Form)
Add the registration link instead of a form ID
This option should be used only in edge cases

[bookmark: CreateanOnDemandPagewithaRecordin]Create an On-Demand Page with a Recording of a Previous Webinar
Use this after the live event to create a page for long-term sharing.
Step 1: Submit Recording for Upload
· Submit the video to the team for editing and Vidyard upload
· Receive the Vidyard video link
Step 2:
Before you begin building your on demand event page in AEM, open the On Demand Template Word Document, make a copy, and fill it out with your event details.
We recommend using the same information from your original live event whenever possible to keep messaging consistent.
You’ll use this document to:
• Finalize all required content for your on demand event page
• Build your page and input the information needed
Step 3: Sign into Adobe Experience Manager
1. Sign into OKTA to access Adobe Experience Manager.
2. Search your OKTA apps for Adobe Experience Manager and click to log in.
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Step 4: Start a New Content Fragment (Page)
1. Click on HigherEd Events Content Fragments.
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2. Select On Demand Events and then the folder for the year the event takes place (e.g., 2025).
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3. In the top-right corner, click Create → Content Fragment.
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4. From the menu, choose Recorded Webinar and click “Next”
[image: ]

Step 5: Create a Title
1. Type your event title into the Title field.
· This will be used to generate the page URL.
· Do not fill in the Description or Tags fields yet.
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AI-generated content may be incorrect.]Only fill in the title and keep the description and tags blank

2. Click the “Advanced” button.
· AEM will automatically add hyphens between words and convert the title to lowercase.
· However, you still need to manually remove any special characters like :, ?, &, /, (), : ,  etc. from the URL field.
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3. Click the blue “Create” button in the top right corner.
4. On the next screen, click “Open” (not “Done”) to begin editing your event page.

Step 6: Fill Out the Content Fragment (Page) for On-Demand Events
Once you’ve created your content fragment using the Blog Recorded Webinar template, you’ll need to complete each field using the guidance below.
Use the content you gathered in the Event Template to fill this out accurately. After completing all fields, click Save, then use the dropdown to choose Save and Close.
✍️ Required Fields
These must be completed for your page to be approved:
· Event Title
Match the title used in promotional materials. (Max 115 characters)
· Subtitle
A short supporting sentence (Max 170 characters)
· SEO Meta Description
Use your subtitle or a short summary (Max 160 characters)
· Tags
Add required tags one folder at a time:
· Business Unit → Higher Education
· Asset Format Type → Blog → Event → Webinar
· Context → Format → On-Demand
· Higher Ed Discipline and related Course(s)
· Publish Date
Set the date your recording should go live
· Event Description
Add the body copy for the page — this supports rich formatting like:
· Bold text
· Hyperlinks
· Bullet points
· Inline images (if needed)
· Video ID
Paste only the ID portion of your Vidyard video (see below):
· If your video URL is:
https://video.mhhe.com/watch/RLecTLMsKukbyKBsvzufuT?
Then the Video ID is: RLecTLMsKukbyKBsvzufuT
· Recording Duration
Total video length in minutes (e.g., 30, 60) (note: this can be a rounded number in 5 min increments, example if it’s actually 49 min long then enter 50)
🧑‍🏫 Optional Fields
These are helpful but not required:
· Speaker Bio
Choose from existing bios in AEM, or create a new one if not already listed. Include name, title, and headshot (150x150 JPG/PNG).
· Social Share Image
Optional custom image for social media preview (617x347px). If not added, a default image will be used.
SAVE YOUR WORK: Once you are done, click save (down arrow), select Save and Close in the top right corner 

[image: ]
Step 7: Creating Your Page
7. Click the alert bell icon in the top-right and select View All. 
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8. Find your new Page Path Selection item and check the box on the image. (You should be able to identify it by it being the most recent one you saved)
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9. Click Complete at the top of the page.
10. Click on the checkbox next to page path
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11. Select the folder for the current year (e.g., 2025) and confirm with a checkbox.

12. Click Select, then OK.

Step 8: Submit the page to be reviewed
9. Go back to the main navigation page (click the AEM Logo in top left corner)
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10. Select HigherEd Events Pages
11. Select the folder you placed your page for example Higher Ed Events | McGraw Hill >  On Demand > 2025, then find your event.
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12. Select your page by clicking the page to create a blue checkmark and select edit at the top of the page.
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13. Then click on the “page information” icon in the top left hand corner of the screen (shown in red box below) 
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14. Select Start Workflow
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15. Scroll down until you see “HigherEd On-Demand Event Publication Request” and click “Start Workflow
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16. The page will refresh and now you’ll see a blue bar at the top, click the Complete link, option: select a future publish date (leave blank if it should publish immediately upon approval), and click OK to complete the workflow.
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17. You have submitted your event page and are complete. The review process will now take 2 business days until it goes live.

Reviews typically take up to 2 business days, though more time may be needed if revisions are required.
Step 8: Share Link for Email Campaigns
After your page is live:
· Share the event page link and description with the Marketo team via Asana to begin building promotional emails.

[bookmark: CreateaNewSpeakerBio]Create a New Speaker Bio if the Person is Not Currently in AEM
Use this if your speaker doesn’t already have a bio.
Step 1: Search for Existing Bio
· Check /content/dam/mhe/content-fragments/blog/blog-authors/higher-ed-authors
· Search by last name as the unique identifier. 
Step 2: Create New Bio If Needed
· First Name, Last Name
· Academic Suffix (if applicable)
· Author Bio
· Author Image (square, 150x150px, jpg/png, lowercase filename with hyphen)

[bookmark: ShareaLiveEventFilteredView]Share a Live Event Filtered View
Use this to share a collection of webinars filtered by discipline, course, topic, or platform.
Steps:
1. Go to Events Directory page
2. Select filters (discipline, course, etc.)
[image: ]
3. Copy filtered page URL
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4. Use in campaigns or sales emails

[bookmark: CreativeReviewInstructions]Creative Review Instructions
Timeline: 1–2 business days
As a reviewer, you'll receive an email notification when an event page is ready for Creative Review.
1. Click the link in the AEM workflow email to go directly to the submitted page.
2. To see how the page looks to end users:
· Click "Page Information" icon (upper left), then choose “View as Published.”
· This will open a clean view of the page, in a new browser tab, as it will appear on mheducation.com.
3. Review layout, branding, spacing, and formatting. Confirm it looks good on both desktop and mobile. Close the tab.
4. If edits are needed:
· Click on the event Title section to open a link to the Content Fragment, make changes, click save and close. Refresh the page to view the updates. 
5. When the page looks good, return to the workflow panel (blue bar in at the top) and click “Complete” to approve the step.

[bookmark: MarketoTechnicalCheckInstructions]Marketo Technical Check Instructions
As a reviewer, you'll receive an email notification when a page is ready for the Marketo check.
1. Click the link in the AEM workflow email to access the page.
· To see how the page looks to end users: Click "Page Information" icon (upper left), then choose “View as Published.”
· This will open a clean view of the page, in a new browser tab, as it will appear on mheducation.com.
2. Test the Marketo form:
· Make sure it’s pulling in the correct form ID: 21552
· Confirm it’s routing to the correct Zoom Meeting or Webinar ID.
· Check that submissions land in the expected Marketo program.
3. If changes are needed:
· Click on the event Title section to open a link to the Content Fragment, make changes, click save and close. Refresh the page to view the updates. 
4. Once all technical items check out, click “Complete” in the workflow panel(blue bar in at the top) to approve.
Timeline: 1–2 business days
You are automatically notified once the workflow is submitted

[bookmark: CreatingTags]Adding Tags (Required for All Event Types)
Tags help categorize and filter your event in the directory. You must use existing tags from structured folders in AEM ⚠️ do not type tags manually.

✅ How to Add Tags in AEM
1. Go to the Tags Field on Your Event Page
· Click the checkbox icon to the right of the field to open the tag folders.
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2. Open Tag Folders
· A folder structure will open. Tags are organized by category (e.g., Business Unit, Format, Programs & Solutions[image: A screenshot of a computer
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3. You Can Only Select One Tag at a Time
· For each tag:
· Navigate to the appropriate folder.
· Click the checkbox to the left of the tag name (it will turn into a blue checkmark).
· Click the Select button to confirm and apply the tag.
· Then reopen the folder to add the next tag.
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📌 Add Required Tags First
Follow these steps in this order to ensure your event is properly tagged:
1. Business Unit
· Folder: Business Unit
· Tag: Higher Education
· ✅ Click the checkbox, then click Select
2. Asset Format Type
· Folder: Asset Format Type > Blog > Event
· Tag: Event
· ✅ Click the checkbox, then click Select
· Folder: Asset Format Type > Blog > Event > Webinar
· Tag: Webinar
· ✅ Click the checkbox, then click Select
3. Context > Format
· Folder: Context > Format
· Choose one:
· Virtual (for webinars)
· In-Person (for physical events)
· ✅ Click the checkbox, then click Select
4. Higher Ed Discipline
· Folder: Higher Ed Discipline
· Tag: Select your discipline (e.g., Business, Science, Humanities)
· ✅ Click the checkbox, then click Select
5. Courses Within Your Discipline
· Reopen your selected discipline folder
· Select all applicable courses (e.g., Accounting, Biology)
· ✅ Click the checkbox for each, then click Select

🧩 Optional Tags (If Applicable)
Add these only if they are relevant to your event:
· Programs & Solutions
· Folder: Programs & Solutions
· Tags: Connect, ALEKS, SIMnet, McGraw Hill GO, eBook, etc.
· ✅ Select one or more, then click Select
· Topics
· Folder: Education Topics
· Tags: Education for All, Artificial Intelligence, Career Readiness
· ✅ Select as needed, then click Select


[bookmark: RequiredFieldReferenceTable]Required Field Reference Table
This table includes the detailed descriptions and character limits for fields in the content fragment. Use this section for more in-depth guidance during training or review.
	Field
	Required
	Description
	Notes

	Event Title
	Yes
	Title shown in search and filters
	Max 115 characters

	Subtitle
	Yes
	One-line teaser or subtitle
	Max 170 characters

	SEO Meta Description
	Yes
	Description for search engine results
	Max 160 characters, follow SEO best practices

	Time Zone
	Yes
	ET, CT, MT, or PT
	Required for live events

	Duration
	Yes
	Length of event in minutes
	Required for live events

	Marketo Form ID
	Yes (if using Marketo)
	Form ID used for registration
	Always use 21552

	Tags
	Yes
	For filtering and organization
	See Creating Tags (Required for All Event Types)

	Speaker
	No
	Name and title
	Optional

	Speaker Image
	No
	Headshot
	Optional

	Social Image
	No
	Thumbnail for social sharing
	Optional — follow social share guidelines



[bookmark: SocialShareImage]Social Share Image Guidelines
The Social Share Image is optional but can enhance how your event appears when shared on platforms like LinkedIn or Facebook.
Requirements:
· 617 x 347 pixels
· JPG or PNG format
· File name should be lowercase with hyphens (e.g., webinar-header-image.jpg)
Best Practices:
· Use a relevant and engaging image (avoid generic stock photos)
· Avoid text in the image.
· Coordinate with Creative if you need help designing a compliant asset
If adding a Social Share Image, upload to Blog Assets folder before starting content fragment step.

[bookmark: PreviewingandReviewingSubmittedPages]Previewing and Reviewing Submitted Pages
Use these steps to view your submitted pages and confirm that your event details were entered correctly.
Step 1: Navigate to the Pages Section
Click on the Adobe Experience Manager logo in the top-left corner.
Select HigherEd Events Pages from the options.
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Step 2: Locate Your Page
Open the folder for the correct year (e.g., 2025) by clicking the arrow to the left of the folder name.
Search for your event by title and click the checkbox to the left of the page to select it.
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Step 3: Edit or Preview the Page
Click Edit to view the full event page and review any information you entered.
Click Preview in the top-right corner to see how your page will appear when published.
This is helpful for reviewing formatting, ensuring tags and descriptions appear as intended, and grabbing copy for promotional use.

[bookmark: Requestaccesstoaem]How to Request Access to AEM
Follow these steps to request access to Adobe Experience Manager if you do not already have it.
Step 1: Submit Access Request Form
Go to this link:
AEM Access Request via ServiceNow
Click on AEM Access Request.
Fill out the form as prompted:
Select Production as the environment.
Submit the form and wait to receive confirmation that your access has been granted.
Step 2: Request Access to Higher Ed Events Folder
After you receive confirmation of AEM access:
Email Susan Etter to request access to the Higher Ed Events access:
📧 Susan.Etter@mheducation.com


[bookmark: TemplateLiveEventPagewithMarketo]Template: Live Event Page with a Marketo Form
	Field
	Instructions
	Example
	Your Event Info

	Event Title
	REQUIRED - Main title seen on the page and in search. Max: 115 characters. 
	Inclusive Teaching in STEM: Strategies That Work
	

	Subtitle
	REQUIRED - Supporting sentence under the title. Max: 170 characters.
	Discover classroom-tested methods to support diverse student success in STEM courses.
	

	Private Event
	REQUIRED - Choose 'Yes' only to hide the event from public listing. Usually 'No'.
	No
	

	SEO Meta Description
	REQUIRED - Text shown in search results. Max: 160 characters. Recommend reusing the subtitle.
	Discover classroom-tested methods to support diverse student success in STEM courses.
	

	Social Share Image
	OPTIONAL - Upload JPG/PNG (617x347px). Defaults to standard image if not uploaded. Use only if a specific image is desired. Social Share Image Guidelines
	inclusive-teaching-stem-webinar.jpg
	

	Tags
	REQUIRED - Only use approved AEM tags. Do not type manually. Must include: Higher Education, Webinar, Format, Discipline & Course. Optional: Platform, Topic. First-time users: refer to the Tags section of the training doc.
	Higher Education, Event, Blog, Webinar, Format “Virtual”, Discipline “Biology”, Course “Microbiology”, Platform “Connect”, Topic “Education for All”
	

	Timeslot(s)
	REQUIRED - Event date and start time 
	September 12, 2025 â€“ 2:00 PM
	

	Webinar ID(s)
	REQUIRED - Zoom/Webinar ID per session.
	789654123
	

	Time Zone
	REQUIRED - Choose ET, CT, MT, or PT.
	ET
	

	Event Duration
	REQUIRED - Total time in minutes (30, 60, 90, 120).
	60
	

	Event Description
	REQUIRED - Main body of the event page. Use bullet points, links, rich text. Can include images.
	Join award-winning professor Dr. Elena Thompson for an engaging session on inclusive teaching practices in STEM.

This webinar will cover:
- Real-world classroom examples that boost equity
- Techniques for engaging underrepresented student groups
- How to use McGraw Hillâ€™s Connect platform to support outcomes

Youâ€™ll leave with practical ideas you can apply this term.
	

	Marketo Form ID
	REQUIRED - Always use 21552 for Higher Ed events.
	21552
	

	Speaker Bio
	OPTIONAL - Include name, title, short bio, and 150x150px JPG/PNG image. If speaker is not in AEM, create a new bio.
	Dr. Elena Thompson
Professor of Biology, Western Lakes University
Dr. Thompson specializes in inclusive pedagogy in STEM. Sheâ€™s a national speaker and recipient of the Inclusive Teaching Award 2023.

Image: elena-thompson.jpg
	



[bookmark: TemplateOnDemandVideoPage]Template: On Demand Video Page
	Field
	Instructions
	Example
	Your Info

	Event Title
	REQUIRED - Title users will see at the top of the event post. Max: 115 characters.
	Inclusive Teaching in STEM: Strategies That Work
	

	Subtitle
	REQUIRED - Supporting sentence under the title. Max: 170 characters.
	Discover classroom-tested methods to support diverse student success in STEM courses.
	

	Private Event
	REQUIRED - Choose 'Yes' only if the event should not appear publicly.
	No
	

	SEO Meta Description
	REQUIRED - Appears in search engine results. Max: 160 characters. Recommend using the subtitle.
	Discover classroom-tested methods to support diverse student success in STEM courses.
	

	Social Share Image
	OPTIONAL - Use JPG or PNG (617x347px). Defaults to standard image if not provided. Only needed if you want a specific image.
ðŸ”— Social Share Image Guidelines: https://example.com/social-share-guidelines
	inclusive-teaching-stem-webinar.jpg
	

	Tags
	REQUIRED - Only use tags from AEMs tag picker. Required: Higher Education, Event, On-Demand. Also include Discipline and Course. Optional: Platform, Topic.
Refer to the Tags section in the training guide for help.
	Higher Education, Event, Format â†’ On-Demand, Discipline â†’ Science, Course â†’ Biology, Platform â†’ Connect, Topic â†’ Education for All
	

	Publish Date
	REQUIRED - Date the on-demand page should be published. Format: Month Day, Year (e.g., September 20, 2025).
	20-Sep-25
	

	Event Description
	REQUIRED - Main content shown on the page. Use headings, bullet points, and rich text. Can include links and images.
	Join award-winning professor Dr. Elena Thompson for an on-demand session on inclusive teaching practices in STEM.

This session covers:
- Real-world classroom examples that boost equity
- Engaging underrepresented student groups
- Using McGraw Hillâ€™s Connect to support learning outcomes
	

	Video ID (Vidyard)
	REQUIRED – The Video ID is the unique code at the end of your Vidyard video URL. This is provided after your recording is uploaded.
You can find it by copying everything after /watch/ in the video link.

📌 Example:
If your video link is:
https://video.mhhe.com/watch/RLecTLMsKukbyKBsvzufuT?
Then your Video ID is:
RLecTLMsKukbyKBsvzufuT

Paste only the ID in the field (not the full URL).
	RLecTLMsKukbyKBsvzufuT
	

	Recording Duration
	REQUIRED - Total length of the video in minutes. Use numeric values (e.g., 30, 60).
	60
	

	Speaker(s) Bio
	OPTIONAL - Include speaker name, title, and short bio. Add a 150x150px headshot (JPG/PNG, lowercase with hyphens). Create new bios in AEM if needed.
	Dr. Elena Thompson
Professor of Biology, Western Lakes University
Dr. Thompson is an expert in inclusive pedagogy in STEM and a national speaker on education equity.

Image: elena-thompson.jpg
	




[bookmark: ContactHelp]Contact & Help
· Creative Questions: Michelle Whitaker
· Marketo Questions: Dave O'Donnell
· Technical/AEM Help: [Insert Name or Help Desk]

Let me know if you encounter issues or need help getting started!
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